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1. Quick Installation Guide 
 
The following is a Quick Guide to the installation of Astral Reports For Dynamics 
NAV. 
 

• Review prerequisites 
• Uninstall previous versions via the control panel 
• Remove the existing Add-In from Excel 
• Run the setup 
• Configure for SQL if required 
• Install the License 
• Test that Astral Reports can connect to Dynamics NAV 
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2. Prerequisites 

2.1. Operating System and Office Software 
Astral Reports can be installed successfully on the following operating systems: 
  

Windows 98 Second Edition Windows Vista 
Windows Millennium Edition Windows 7 
Windows 2000 Windows Server 2003 
Windows XP Windows Server 2008 

 
Astral Reports has been designed to work successfully on Microsoft Office 2000 
through to Microsoft Office 2010 
 

2.2. Microsoft Dynamics NAV SDK (C/Front) 
Prior to installation of Astral Reports for Dynamics NAV, C/Front must be installed. 
In earlier versions of Dynamics NAV(before V5), C/Front can be installed from the 
Dynamics NAV CD by following the instructions to install C/Front. In the most 
recent versions, C/Front is installed as part of the SDK (Software Development Kit), 
customise your installation of NAV and ensure you select C/Front to run from your 
PC. 
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2.3. Microsoft Dynamics NAV License 
C/Front requires a copy of the Dynamics NAV License File, (this is the file with the 
.FLF extension) to be stored into the Client Directory within the Dynamics NAV 
application installation directory. Therefore, before installation, it is recommended 
that this action be performed.  
Depending on your version of NAV this will be something like: 
C:\Program Files (x86)\Microsoft Dynamics NAV\60\Classic\fin.flf 
 
If you have Microsoft Dynamics NAV version 5.0 or later or you have updated your 
license to the Business Ready Licensing model, then CFRONT will be a part of your 
licence. Otherwise the C/Front granule must be purchased from Microsoft via your 
reseller. To see whether your license covers the use of C/Front, select “License” from 
the tools menu and look for Granule ID 1,800 
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3. Astral Reports Installation 

3.1. Uninstall Previous Versions 
Ensure that the Excel application is not open. 
 
From the Windows Start button, select “All Programs” and then “Astral Reports For 
Dynamics NAV” and then select the “Uninstall Astral Reports For Dynamics NAV” 
shortcut. 
 

 
 
Alternatively, use “Add or Remove Programs” from the Windows Control Panel. Find 
the “Astral Reports For Dynamics NAV” entry and click the “Remove” button. 
You will then be prompted as to whether you wish to remove the programme. 
 

 
 
 
The Programme will then be uninstalled 
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The final step is to open the 
Microsoft Excel application and 
remove the Add-In file from the 
list of available Add-Ins. The 
“Remove Add In From Excel” 
shortcut mentioned above merely 
disables the Add In file, it does not 
actually remove it.  
 
To do this, go to the File menu and 
select Options and then select 
Add-Ins, making sure the 
“Manage” Option is set to Excel 
Add-Ins press the Go button. 
 
 
 
 
 
 
(Alternatively for Office 2003, select Add-Ins from the Tools menu).  
Move down the list using the arrow keys, and when the “Astral Reports For Dynamics 
NAV” entry is reached, Excel will prompt you with the following message: 
 
 
 

 
 
 
Click “Yes” to the message and then click “OK” on the “Add-Ins” form. Then close 
down Excel. 
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3.2. Installing Astral Reports 
If the installation application has been downloaded from the www.astralreports.co.uk 
website as a zip file, unzip the contents of the file to your local hard drive or shared 
network drive. 
 
 

 
 
Now double-click the “Setup.Exe” file to start the installation. 
 

 
 
 
For later versions of Windows you will 
have to say yes to the user account 
control to load the programme. 
 
 
 
 
 
 

 
 
Follow the onscreen 
instructions to install Astral 
Reports, ensuring that you 
read the license file before 
accepting it. 
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There are 3 types of installation available : 
 
Typical:  Installs all programme 
files, the latest version of 
CFRONT (currently 6.0 R2) plus 
the example Excel reports. 
 
Compact: Installs all programme 
files, and the latest version of 
CFRONT (currently 6.0 R2) 
 
Custom: Installs all programme 
files, and allows the user to select 
all versions of CFRONT from 
version 4 SP3 onwards and the 
Example reports as required 
 
If you are running any version of NAV earlier than 2009 R2 you will need to select 
the Custom type and install the optional CFRONT files.  

 
 
 
 
If your version of NAV is 
earlier than version 4 SP3 
then please refer to 
Appendix A - How to 
install CFRONT for 
versions of NA prior to 
V4SP3. 
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NOTE:  
It is recommended that the default installation location is NOT changed.  
 
Since Astral Reports 
allows you to 
include custom built 
functions within a 
spreadsheet, the 
function will be 
referencing a 
function that is 
contained in another 
file.  
Should the 
spreadsheet be 
opened by another 
user, Excel will look 
for the function 
within the same file 
in the same location 
on their C drive. 
 
If you do wish to install the functions to an alternate location, all other installs should 
use the same alternative location. 
 
Confirm setup settings by pressing Next and the programme will be installed. 
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3.3. After Installation 
 
After the above procedures have been followed, Astral Reports will be ready for use. 
To check that the installation was successful, open Microsoft Excel.  
 
 
Depending on your version of Excel you will either see the “Astral” drop down menu. 
Microsoft Office 2003 or earlier. 
 

 
 
 

 
 
 
If you have Microsoft Excel 2003 onwards you will see the new ribbon toolbar. 
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3.4. Changing the Language 
Astral Reports installs with the English language (ENG) as a default. To change the 
language, select “Set Language” from the Astral Reports Options menu item. 
 

 
Select your 
preferred language 
from the drop 
down list and then 
select “OK”. After 
selecting OK, the 
menu captions and 
form captions will 
update, and the 
Help File 
automatically 
linked to the 
correct Help File. 
 

 
For more information on changing Language codes please look at our online video or 
help regarding installing languages. 
 
 
 

3.5. Security 
Each user will need to have a base level of permissions in each company. These 
permissions are simply to allow C/Front the ability to evaluate whether the user has 
further permissions for the desired data. 
 
The simplest method of configuring the Dynamics NAV security is to create a new 
“Role” called “Astral” in Dynamics NAV (if the user is a Super user this step is not 
required). 
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Within this Role, permissions are required for three items. 
 

 
 
The “Object” Table Data allows Astral Reports to evaluate whether the user has 
permissions for a certain table within the required company, and the “Company” 
Table Data allows Astral Reports to build a dropdown list of companies for use when 
retrieving data from Dynamics NAV. 
 

 
 

Once the Role is created, you 
will need to assign this Role to 
each user that will be using 
Astral Reports.  
 
For users with Windows 
Logins, assign the Role and 
either Synchronise a Single 
Login or All Logins, 
depending on security settings. 
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3.6. Configuring Fields for Drilldown 
On first connection, default drilldown fields are configured. These can be changed at 
any time by opening the “Drilldown Fields Selection” form. 

 
 
 
 
 
 
 
 
 
 

Before opening the form, a connection to Dynamics NAV must have been established. 
 

 
 
Once a connection has been established, the user can double-click the various 
drilldown enabled tables and double-click on the fields to toggle the field on/off. 
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Once finished, clicking “Save” will store the required field combinations to the 
computers registry. 
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4. Testing Dynamics NAV C/Front connection 

4.1. Establishing Dynamics NAV Connection Method 
The simplest method to establish how you connect to Dynamics NAV is from within 
the Dynamics NAV classic application itself, (if you run the Role Tailored Client you 
are connecting through SQL). Open up Dynamics NAV as normal, and when you are 
connected to your Dynamics NAV Database, select “File” and then “Database”. 
 
For installations that use the native database format, you will be displayed with a 
three tabbed form, and for SQL installations you will see a two tabbed form. 
 
Native Installations 
 

 
 
If the Connection is shown as “Local”, you will need to look at the database tab and 
make a note of the entry within the “Database Name” field. If the Connection is 
shown as “Server”, make a note of the entry in the “Server Name” field. 
 
SQL Installation 
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If the Connection is shown as SQL, you will need to make a note of the “Server 
Name” and the “Database Name” shown on the Database tab. 
 

4.2. Configuring Astral Reports to use SQL 
By default, Astral Reports is configured for Microsoft Dynamics NAV’s native 
database format. If you have established that the SQL database format is being used, 
you will need to perform one additional configuration step prior to connection. 
 
From the “Astral” menu within Excel, select “Options” and then “Set Database 
Format to SQL”. 
 

  
Select “Yes” at the confirmation dialog that is displayed. 
 
 

 
 
At this stage you are informed that Excel must be closed and then reopened for the 
changes to take effect. After reopening you will note that the “Set Database Format to 
SQL” menu item has changed to “Set Database Format to Native” 
 

4.3. Installing the Astral Reports License File 
If you have obtained an Astral Reports license file that is linked to your own 
Dynamics NAV license file, or wish to use a demonstration license, you can do so by 
selecting the “License” button from the “About” form. 
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This will initially display an 
entry screen, but after browsing 
for the license file it will display 
it within the form. 
 
 
 
 
 
 
 
 

 
 
It is suggested that the license be placed into 
the Astral Reports installation directory, or 
within a shared folder on the network. 
 
NOTE: 
Each Astral Reports license file is linked to a 
Dynamics NAV license file via the 
“Dynamics NAV License No.” 
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4.4. Making the first connection 
At this stage, you are ready to test your connection from Astral Reports to Dynamics 
NAV. 
 
From the “Astral” menu within Excel, select “Database” and then “Open”, or click on 
the open icon on the ribbon  
 

 
 
 
 

 
 
Enter the connection information obtained from the procedures above, and select NT 
Authentication if you normally connect to Dynamics NAV without requiring a User 
name and Password. 
 
Click “Open” and if no error message is displayed; Astral Reports has successfully 
connected to Dynamics NAV. 
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5. Using the Custom Functions 
Astral Reports uses the concept of providing functions that are based on Dynamics 
NAV’s SIFT technology. Each function utilises this technology, and therefore 
provides a “highly tuned”, predetermined structure for extracting information from 
the system. 
 
To see the extensive list of functions, click on the drop down box that is next to the 
“Auto Sum” icon on the toolbar, and select “More Functions”. 
 
 

 
 
 
 
Alternatively, go to the Formulas menu and select “Insert Function”. 
 
 

 
 
 
Or select Insert function from the Astral Reports ribbon 
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Now, from the “Insert Function” form, change the “Category” to “Astral Reports” and 
you will be displayed with a complete list of the functions. 
 
 
 

 
 



   
Astral Reports Installation 
Guide 

Version 3.1 Page 22 of 27 
 

Copyright Astral Reports Limited - All rights reserved 
 

6. Help 
The “Help File” that is included as part of the installation is the best source of 
information relating to the functions that are now available to you for use within 
Excel. This help file can be opened from each “Astral Reports” form that is displayed, 
and additionally, from the “Help on this function” link which can be found at the 
bottom left of Excel’s standard “Insert Function” form. 
 
The following are examples of how the Help File can be accessed. 
 
From the “Insert Function” form 
 

 
 
 
From the “About” form 
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From the “Database Open” form 
 

 
 
 
From the Astral Reports ribbon, select Online Help. 
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Troubleshooting 
The following are known issues relating to connecting C/Front to Dynamics NAV. 
 

� Incorrect Version of C/Front 
The installed version of C/Front must correspond to the installed version of Dynamics 
NAV. The safest method here is to install C/Front from your original Dynamics NAV 
CD. However, some CDs for older versions of Dynamics NAV (Version 2.01 for 
example) incorrectly shipped the wrong version of C/Front. 
 
If you are faced with this issue, contact your reseller to provide you with the correct 
version for your Dynamics NAV installation. 
 

� The Database File is already in use 
If testing Astral Reports for demonstration purposes, you may have the Dynamics 
NAV application open with a direct connection to a local database. Since this type of 
connection a single user only connection, Astral Reports will not be able to connect 
until Dynamics NAV is closed. However, the functions may still be used, but they 
will return “#NC#”, meaning “No Connection”. 
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Appendix A  

How to install C/Front for versions of NAV prior to  V4SP3 
 
If you have installed Astral Reports utilising either, Typical, Compact or Custom, you 
will have created at least one CFRONT version in the CFRONT directory of Astral 
Reports for Dynamics NAV. 
 
C:\Program Files (x86)\Astral Reports\Astral Reports For Dynamics NAV\CFront 
 
 

 
 
Here we have used the Custom install 
facility to install all of the versions 
available. 
 
 
 
 
 

 
If I wished to install a new version of CFRONT manually all I need to do is to copy 
all of the file types held in one of these directories, from my Dynamics NAV DVD or 
network location if I have the install files held here. 
 
The first thing I do is to create a new CFRONT  version folder, in this instance I have 
created a version V370HF1, make sure this is the latest version you are running, 
especially where several hotfixes were created. 
 

 
 
 
From my network location (DVD) I locate the SDK folder, and the CFRONT folder 
within this: 
V370HF1\Devkit\Program Files\Microsoft Business Solutions-
Navision\SDK\CFRONT. 
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From this directory I take just the two CFRONT files:  

• CFRONT.DLL  
• cfrontsql.dll 

And copy these into my new directory. 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
I then go to the main client directory on the DVD or 
network location: 
 

 
V370HF1\Client\Program Files\Microsoft Business 
Solutions-Navision\Client\ 
 
Copy the rest of the files into the directory V370HF1 
 
(You will notice we did not have Nc_tcps.dll in 
version 3.70, as this network protocol was not 
avaialble at this time.) 
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After creating the new directory and copying the files, simply change the version of 
C/Front being used by selecting the new version in the Settings >> Options form. 

 

 

 
 
 


